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Thank You for Choosing Ross
You've made a great choice. We expect you will be very happy with your purchase of Ross Technology. 

Our mission is to:

1. Provide a Superior Customer Experience

• offer the best product quality and support

2. Make Cool Practical Technology

• develop great products that customers love

Ross has become well known for the Ross Video Code of Ethics. It guides our interactions and 
empowers our employees. I hope you enjoy reading it below.

If anything at all with your Ross experience does not live up to your expectations be sure to reach out to 
us at solutions@rossvideo.com.

David Ross
CEO, Ross Video
dross@rossvideo.com

Ross Video Code of Ethics
Any company is the sum total of the people that make things happen. At Ross, our employees are a 
special group. Our employees truly care about doing a great job and delivering a high quality customer 
experience every day. This code of ethics hangs on the wall of all Ross Video locations to guide our 
behavior:

1. We will always act in our customers’ best interest.

2. We will do our best to understand our customers’ requirements.

3. We will not ship crap.

4. We will be great to work with.

5. We will do something extra for our customers, as an apology, when something big goes wrong and 
it's our fault.

6. We will keep our promises.

7. We will treat the competition with respect.

8. We will cooperate with and help other friendly companies.

9. We will go above and beyond in times of crisis. If there's no one to authorize the required action in 
times of company or customer crisis - do what you know in your heart is right. (You may rent 
helicopters if necessary.)
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Important Regulatory and Safety Notices to Service Personnel

Before using this product and any associated equipment, read all the Important Safety Instructions listed below so 
as to avoid personal injury and to prevent product damage.

The OverDrive system makes use of a number of individual component products to make up a complete turnkey 
system. The Important Safety Instructions section of this manual is intended to compliment individual OEM 
product manuals and the User must refer to, and heed, any safety instruction outline in these supplementary product 
manuals. Separate manuals are included for the following component products:

• Server PC(s)

• LCD Flat Screen Display(s) & Power Supply

This system may also require specific equipment, and /or installation procedures be carried out to satisfy certain 
other regulatory compliance requirements. Notices have been included in this publication to call attention to these 
specific requirements.



Symbol Meanings

Protective Earth — This symbol identifies a Protective Earth (PE) terminal, which is provided for 
connection of the supply system’s protective earth (green or green/yellow) conductor.

This symbol on the equipment refers you to important operating and maintenance (servicing) instructions 
within the Product Manual Documentation. Failure to heed this information may present a major risk of 
damage or injury to persons or equipment.

Warning — The symbol with the word “Warning” within the equipment manual indicates a potentially 
hazardous situation which, if not avoided, could result in death or serious injury.

Caution — The symbol with the word “Caution” within the equipment manual indicates a potentially 
hazardous situation which, if not avoided, may result in minor or moderate injury. It may also be used to 
alert against unsafe practices.

Warning Hazardous Voltages — This symbol is intended to alert the user to the presence of 
uninsulated “dangerous voltage” within the product enclosure that may be of sufficient magnitude to 
constitute a risk of shock to persons.

ESD Susceptibility — This symbol is used to alert the user that an electrical or electronic device or 
assembly is susceptible to damage from an ESD event.



Important Safety Instructions

• Read these instructions. 

• Keep these instructions.

• Heed all warning.

• Follow all instructions.

Warning The safe operation of this product requires that a protective earth connection be provided. 
A grounding conductor in the equipment's supply cord provides this protective earth. To 
reduce the risk of electrical shock to the operator and service personnel, this ground 
conductor must be connected to an earthed ground.

Use only power cords specified for this product and certified for the country of use. Refer 
to the Product Power Cord Requirement Section that follows. 

Do not defeat safety purpose of the grounding-type plug. A grounding type plug has two 
blades and a third grounding prong. The third prong is prong is provided for your safety. If 
the provided plug does not fit in to your outlet, consult an electrician for replacement of 
the obsolete outlet.

Protect the power cord from being walked on or pinching particularly at plugs, 
convenience receptacles, and point where they exit from the apparatus.

Warning Indoor Use: “WARNING – TO REDUCE THE RISK OF FIRE OR ELECTRIC SHOCK, 
DO NOT EXPOSE THIS APPARATUS TO RAIN OR MOISTURE”

Do not use this apparatus near water.

Do not block any ventilation openings. Install in accordance with manufacturer’s 
instructions. 

Do not install near heat sources such as radiators, heat registers, stoves, or other apparatus 
(including amplifiers) that produce heat.

Only use attachments/accessories specified by the manufacturer.

Unplug this apparatus during lightning storms or when unused for long periods of time.

Clean only with a dry cloth.

Warning Refer all servicing to qualified personnel. Servicing is required when the apparatus has 
been damaged in any way, such as power-supply cord or plug damage, liquid has been 
spilled or objects have fallen into the apparatus, the apparatus has been exposed to rain or 
moisture, does not operate normally, or has been dropped.

Caution  To reduce the risk of fire, replacement fuses must be the same type and rating.

Warning This product contains safety critical parts, which if incorrectly replaced may present a risk 
of fire or electrical shock. Components contained within the product’s power supplies and 
power supply area, are not intended to be customer serviced and should be returned to the 
factory for repair



Product Power Cord Requirements

EMC Notices

US FCC Part 15

This equipment has been tested and found to comply with the limits for a class A Digital device, pursuant to part 15 
of the FCC Rules. These limits are designed to provide reasonable protection against harmful interference when the 
equipment is operated in a Commercial environment. This equipment generates, uses, and can radiate radio 
frequency energy and, if not installed and used in accordance with the instruction manual, may cause harmful 
interference to radio communications. Operation of this equipment in a residential area is likely to cause harmful 
interference in which case the user will be required to correct the interference at his own expense.

CANADA

This Class “A” digital apparatus complies with Canadian ICES-003. 

Cet appareil numerique de la classe “A” est conforme a la norme NMB-003 du Canada.

EUROPE

This equipment is in compliance with the essential requirements and other relevant provisions of CE Directive 
93/68/EEC.

INTERNATIONAL

This equipment has been tested to CISPR 22:1997 along with amendments A1:2000 and A2:2002 and found to 
comply with the limits for a Class A Digital device.

Warning North American Line Voltages 100 - 120 Volt 
This product is supplied with certified 10A/125V SVT type supply cords. 

Conductors are color coded white (neutral), black (line) and green or green/yellow 
(ground). 

Operation of this equipment at line voltages exceeding 130V requires that alternative 
supply cords with appropriate voltage and current ratings be used.

Warning International Line Voltages 200 - 240 Volt 
This product has been designed for use with certified IEC 320- C13 10A/250V - H03 
VV-F3G 1.00mm2 type line cord. 

International product orders are supplied with a certified 10A/250V line cords, utilizing a 
molded 3-pin IEC 320-C13 type connector at one end and stripped conductors on the 
other. One line cord is provided. Conductors are CEE color coded; blue (neutral), brown 
(line), and green/yellow (ground). 

Installation by a qualified Electrician, of an appropriately approved A/C wall plug 
certified for the country of use, is required.

Alternatively, other IEC 320 C-13 type power cords may be used, provided that they meet 
the necessary safety certification requirements for the country in which they are to be 
used. Refer to the correctly specified line cord above.

Notice Changes or modifications to this equipment not expressly approved by Ross Video Ltd. could 
void the user’s authority to operate this equipment.

Notice This is a Class A product. In domestic environments, this product may cause radio interference, 
in which case the user may have to take adequate measures.



Warranty and Repair Policy

The OverDrive Live and OverDrive News systems are backed by a comprehensive one-year warranty on all 
components.

If an item becomes defective within the warranty period Ross will repair or replace the defective item, as 
determined solely by Ross.

Warranty repairs will be conducted at Ross, with all shipping FOB Ross dock. If repairs are conducted at the 
customer site, reasonable out-of-pocket charges will apply. At the discretion of Ross, and on a temporary loan basis, 
plug in circuit boards or other replacement parts may be supplied free of charge while defective items undergo 
repair. Return packing, shipping, and special handling costs are the responsibility of the customer.

This warranty is void if products are subjected to misuse, neglect, accident, improper installation or application, or 
unauthorized modification.

In no event shall Ross Video Limited be liable for direct, indirect, special, incidental, or consequential damages 
(including loss of profit). Implied warranties, including that of merchantability and fitness for a particular purpose, 
are expressly limited to the duration of this warranty.

This warranty is TRANSFERABLE to subsequent owners, subject to Ross’ notification of change of ownership.

Extended Warranty

For customers that require a longer warranty period, Ross offers an extended warranty plan to extend the standard 
warranty period by one year increments. For more information about an extended warranty for your OverDrive 
system, contact your regional sales manager.

Environmental Information

The equipment that you purchased required the extraction and use of natural resources for its production. It may 
contain hazardous substances that could impact health and the environment.

To avoid the potential release of those substances into the environment and to diminish the need for the extraction 
of natural resources, Ross Video encourages you to use the appropriate take-back systems. These systems will reuse 
or recycle most of the materials from your end-of-life equipment in an environmentally friendly and health 
conscious manner.

The crossed-out wheeled bin symbol invites you to use these systems.

If you need more information on the collection, reuse, and recycling systems, please contact your local or regional 
waste administration.

You can also contact Ross Video for more information on the environmental performances of our products.

Notice — Changes or modifications to this equipment not expressly approved by Ross Video Limited 
could void the user’s authority to operate this equipment.



Use of Hazardous Substances in Electrical and Electronic Products (China RoHS)

Ross Video Limited has reviewed all components and processes for compliance to:

“Management Methods for the Restriction of the Use of Hazardous Substances in Electrical and Electronic 
Products” also known as China RoHS.

The “Environmentally Friendly Use Period” (EFUP) and Hazardous Substance Tables have been established for all 
products. We are currently updating all of our Product Manuals.

The Hazardous substances tables are available on our website at:

http://www.rossvideo.com/about-ross/company-profile/green-practices/china-rohs.html 

电器电子产品中有害物质的使用 

Ross Video Limited 按照以下的标准对所有组件和流程进行了审查： 

“电器电子产品有害物质限制使用管理办法”也被称为中国RoHS。 

所有产品都具有“环保使用期限”(EFUP）和有害物质表。目前，我们正在更新我们所有的产品手册。 

有害物质表在我们的网站： 

http://www.rossvideo.com/about-ross/company-profile/green-practices/china-rohs.html 

Company Address

Ross Video Limited 

8 John Street
Iroquois, Ontario
Canada, K0E 1K0

Ross Video Incorporated 

P.O. Box 880
Ogdensburg, New York
USA 13669-0880

General Business Office: (+1) 613  652  4886

Fax: (+1) 613  652  4425

Technical Support: (+1) 613  652  4886

After Hours Emergency: (+1) 613  349  0006

E-mail (Technical Support): techsupport@rossvideo.com

E-mail (General Information): solutions@rossvideo.com

Website: http://www.rossvideo.com

mailto:solutions@rossvideo.com?Subject=Information%20Request&Body=Hi,%0D%0D
http://www.rossvideo.com
http://www.rossvideo.com/about-ross/company-profile/green-practices/china-rohs.html
http://www.rossvideo.com/about-ross/company-profile/green-practices/china-rohs.html
mailto:techsupport@rossvideo.com?Subject=Information%20Request&Body=Hi,%0D%0D
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Introduction
On behalf of our team here at Ross Video, I would like to thank you for choosing to buy a Streamline Play system.

We are committed to providing you with the highest level of customer satisfaction possible. If, for any reason, you 
have questions or comments, please call Ross Video at +1-613-652-4886 or send us an e-mail at 
techsupport@rossvideo.com.

We hope that you visit our website www.rossvideo.com to stay up to date with ongoing software releases, join our 
customer forum and learn more about the complete range of Ross Video products.

Note that software maintenance and extended warranties are available for your system to protect and extend the life 
of your investment. Our sales team are more than happy to provide further information on the plans available. 
Members of our sales team promptly response to e-mails sent to: solutions@rossvideo.com.

Again, thank you for your purchase of a Streamline Play system from Ross Video. We know that you will be very 
pleased with your decision. 

Yours Sincerely,

Peter Abecassis
Director of Product Management - Production Workflow
peter.abecassis@rossvideo.com
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About This Guide

This guide contains the following chapters that cover the configuration and use of Streamline Play software:

1. “Introduction” summarizes the guide and provides important terms, conventions and feature descriptions.

2. “Manage Assets” describes how to upload and manage assets in a Streamline Play system.

3. “Add Assets to NRCS Stories” describes how to add Streamline assets to NRCS rundowns. 

4. “Rundown Playout” describes how to playout a rundown.

If you have questions pertaining to the operation of the Ross Video product, please contact us at the numbers listed 
in the section “Contacting Technical Support” on page 1–3. Our technical staff is always available for 
consultation, training, or service.

Documentation Conventions

Special text formats are used in this guide to identify parts of the user interface, text that a user must enter, or a 
sequence of menus and sub-menus that must be followed to reach a particular command.

Interface Elements

Bold text is used to identify a user interface element such as a dialog box, menu item, or button. For example:

In the Work Order Manager panel, click Create New Work Order.

User Entered Text

Courier text is used to identify text that a user must enter. For example:

In the Language box, enter English.

Referenced Guides

Italic text is used to identify the titles of referenced guides, manuals, or documents. For example:

For more information, refer to the section “Creating a Work Order” in the Streamline Play User Guide.

Menu Sequences

Menu arrows are used in procedures to identify a sequence of menu items that you must follow. For example, if a 
step reads “File > Save As,” you would click the File menu and then click Save As.

Important Instructions

Star icons are used to identify important instructions or features. For example:

When Streamline Play cannot connect to the network, a Message dialog box opens to report the connection 
problem.
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Getting Help

The Ross Video product Online Help system is accessed by selecting Help Topics from the Help menu in the 
product. Alternatively, press the F1 key while working in a client or dialog box.

The Online Help system contains the following navigation tabs to locate information contained in the Online Help 
topics and User Guide:

• Contents — table of contents

• Index — keyword reference

• Search — full text search

• Favorites — preferred information storage and access

Ross Video product guides are also supplied as print-ready PDF files on the Ross Video product Software 
Installation DVD.

Contacting Technical Support

Technical Support is staffed by a team of experienced specialists ready to assist you with any question or technical 
issue.

Ross Video has technical support specialists strategically located around the globe to ensure a prompt response to 
technical inquiries. Our primary technical support center is located in Ottawa, Ontario, Canada. In addition, we 
have offices in The United Kingdom (London), Australia (Sydney), and Singapore with satellite locations in New 
York City, The Netherlands, and China. As we expand our presence globally, we are constantly evaluating other key 
locations to have a local technical support specialist in order to better service our customers.

North America

Our North America center located in Ottawa, Ontario, Canada and is open Monday to Friday 8:30 a.m. to 6:00 p.m. 
EST, with 24/7/365 on-call service after hours.

Our telephone number is: +1-613-686-1557

Toll free within North America: +1 833-859-0499

EMEA

Our EMEA center is open Monday to Friday 8:30 a.m. to 5:00 p.m. GMT. After hours support is provided by our 
North America location.

International toll free: +800 3540 3545

If the local support specialist is not available, your call will be transferred automatically to our North America 
center.

Australia

Our Sydney, Australia office is located in Alexandria, NSW.

Our local support telephone number is: 1300 007 677

If the local support specialist is not available, your call will be transferred automatically to our North America 
center.

Online

E-mail: techsupport@rossvideo.com 

Website: open a support request using the link https://support.rossvideo.com/ to open a support request.

mailto:techsupport@rossvideo.com?Subject=Information%20Request&Body=Hi,%0D%0D
https://support.rossvideo.com/
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Manage Assets
The asset management component of a Streamline Play system enables you to upload and manage digital media 
content. Streamline Play enables you to manage assets through a single user interface over the Internet.

The following topics are discussed in this chapter:

• Supported Formats

• Start Streamline Play

• Exploring the Streamline Play User Interface

• Panel Positions and Perspectives

• Uploading Assets

• Requesting Approval for an Asset

• Previewing a Media File

• Approving and Rejecting an Asset
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Supported Formats

The following sections describe the media formats supported by the Streamline Play system.

Thumbnail Viewing

Streamline Play supports the following image formats for thumbnail viewing:

• BMP

• GIF

• JPG

• PNG

• TGA

• TIF

• WBMP

A PNG thumbnail is generated when Streamline Play encounters one of the support formats. This thumbnail is 
scaled down to fit within a 256x144 image. 

Video Playout

Streamline Play supports video playout within your web browser using Flowplayer for the following formats: 

Metadata Collection

Streamline Play supports the gathering of structural metadata using the MediaInfo tool. Refer to the MediaInfo 
website for a list of analytics and supported media file formats.

Start Streamline Play

Streamline Play enables you to manage assets through a single user interface over the Internet.

To start Streamline Play

1. Use one of the following supported web browsers to open the Streamline Play web page provided by your 
Streamline Play administrator:

• Microsoft Internet Explorer® version 9 or greater

• Mozilla Firefox® version 3.6 or greater

• Google Chrome™ browser version 17.x or higher

• Apple Safari® version 5.1.x or greater

The Login panel opens.

Table 2.1  Supported Video Formats for Playout

Format Video Codec Audio Codec

F4V H.264 AAC

FLV Sorenson H.263 MP3

MP4 H.264 AAC
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2. In the Login panel, type your Streamline Play login credentials in the Username and Password boxes.

3. Click Login.

Streamline Play opens.

 If a message indicates that the system is in maintenance mode, a system administrator must establish a database 
connection before you can log in as a Streamline Play user.

To close Streamline Play, click the  Logout icon in the main toolbar.

To close Streamline Play

• On the main toolbar, click the  Logout icon.

Exploring the Streamline Play User Interface

The Streamline Play user interface consists of a main toolbar and several types of workspace panels that open as 
required.

Main Toolbar

The main toolbar is located at the top of the Streamline Play interface. The icons in the main toolbar enable you to 
open workspace panels to access almost all features of Streamline Play. The icons that you access from the main 
toolbar depend on the features your organization purchased and the user permissions that your Streamline Play 
administrator assigned to your user account.

Figure 2.1  Streamline Play Main Toolbar

The main toolbar contains the following icons:

Table 2.2  Main Toolbar Icons

Icon Name Description

Asset Upload Open the Upload panel to select media files to copy from a 
specific location to the Streamline Play system.

Asset Browse Open the Assets panel to view the assets stored in your 
Streamline Play system.

Assets Pending 
Approval

Open the Asset Approvals panel to view the assets currently 
pending your approval.

Work Orders Opens the Work Orders panel that enables you to submit 
requests for asset creation.

Tasks Opens the Tasks panel to monitor the status of running and 
completed tasks on the Streamline Server.

Messaging Opens the Messaging Manager panel to monitor the online status 
of users on an Inception Server, create new conversations, and 
manage the conversations in which you are involved.

Report Manager Opens the Reports panel that enables you to create, recall, and 
run reports using specific criteria. 
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Panel Positions and Perspectives

When accessed from a desktop computer, the Streamline Play user interface layout consists of the main toolbar plus 
eight panel positions. Each panel position can contain zero or more types of Streamline Play panels. If some 
positions are unoccupied, Streamline Play optimizes the layout by expanding open panels to fill all available space. 
By default, Streamline Play does not occupy all eight panel positions. 

Figure 2.2  Arrangement of the Eight Panel Positions

A user perspective is a customized view of the Streamline Play user interface. It is a mapping of Streamline Play 
panel types to positions in the user interface layout. Perspectives also save the columns displayed in the Assets and 
Asset Approvals panels.

All Streamline Play users can create perspectives for their own use. Streamline Play administrators can also create 
global perspectives available to all users.

 Panels may not always appear exactly where you expect. As you open and close panels, Streamline Play adjusts 
the layout to optimize use of the available space. For example, if the current perspective includes an Asset Editor 
panel in the right column and you use it to open only an Asset Editor panel, the Asset Editor panel occupies all of 
the available space. As you open more panel types, Streamline Play adjusts the layout to conform with the 
perspective.

Configuration Open the Configuration interface to configure Streamline Play 
system options.

Change Password Change the password you use to log in to Streamline Play.

Perspectives Switch to a different layout (perspective), or to manage saved 
perspectives available in the Streamline Play system.

Help View the Online Help system.

Logout End the current session and log out of the Streamline Play.

Table 2.2  Main Toolbar Icons

Icon Name Description
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Default Panel Positions

When you first use Streamline Play, it opens certain types of panels in certain panel positions by default. Streamline 
Play continues to use the default layout until you move a panel or open a saved perspective. If you revert your panel 
layout to the default panel layout, Streamline Play also reverts the columns displayed in the Assets and Asset 
Approvals panels to default columns. Figure 2.3 describes the default Streamline Play layout. Streamline Play 
optimizes the layout by expanding open panels to fill all available space.

Figure 2.3  Default of Panel Layout

Default layout positions are as follows:

• Grid-based panels open in the middle position. The Assets and Asset Approvals panels are grid-based panels.

• The Asset Editor panel opens in the right column.

Move a Panel from One Layout Position to Another

You can move panels between layout positions to customize the layout to suit your typical workflow.

To move a panel from one layout position to another

1. At the top of the panel you want to move, click and drag the panel’s name tab.

2. Drag the pointer over the layout guide to specify the position to which you want to move the panel.

As you drag the pointer over the layout guide, the current drop position for the panel turns yellow. Light gray 
indicates unoccupied positions. Dark gray indicates occupied positions that can accept additional panels.

3. When the position to which you want to move the panel turns yellow, release the mouse button.

After you have arranged panels to your liking, you can save the layout as a perspective.

Rearrange Panel Tabs Within a Layout Position

You can rearrange the order of panel tabs within a layout position to customize the layout to suit your typical 
workflow.

To rearrange the order of panel tabs within a layout position

1. Click and drag the panel’s name tab within the tab row at the top of the layout position.

As you drag the pointer over the tab row, a dotted rectangle indicates the current drop position for the selected 
panel tab. If the rectangle surrounds a tab name, the drop position is to the left of that tab.

2. When the dotted rectangle indicates the desired position, release the mouse button to drop the panel tab.

You can also move a panel to a different layout position by dragging and dropping the panel name tab into the 
tab row of the destination panel. After you have arranged panel tabs to your liking, you can save the layout as a 
perspective.
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Navigating within Panels

This section describes how resize and close panels, and how to navigate within column-based panels.

To resize a panel

• Hover the mouse pointer over an edge or corner of the panel until the resizing icon displays, and then click and 
drag the edge or corner.

 Streamline Play does not save custom panel sizing as part of a perspective.

To close a panel

• Click the  close icon in the top right corner of the panel.

If the layout position contains more than one open panel, only the current panel closes.

Column-Based Panels

Column-based panels consist of horizontal rows, each of which represents an asset, or a work order. Each vertical 
column contains one type of information about the rows.

The following panel types are column-based:

• Asset Approvals

• Assets

The following table describes how to navigate within a column-based panel.

Table 2.3  Column-based Panel Navigation

Desired Effect Action to Perform

To move between cells Press the Arrow keys (Up, Down, Left, or Right).

Alternatively, to move horizontally, press Tab or Shift+Tab.

To select a row Click the row, or press the Up and Down Arrow keys to navigate to the 
row.

Yellow shading highlights the selected row.

To select a range of rows Click the first row in the selection range, and then Shift-click the last row 
in the selection range.

The row selection includes the first selected row, the last selected row, and 
all of the rows between the two selected rows.

To select multiple rows Click the first row to select, and then CTRL-click additional rows to add 
to the selected row.

To select all rows Click a row, and then press CTRL+A.

Streamline Play selects all of the rows in a panel.

To select a cell Click the cell, or navigate to it by pressing the Arrow keys (Up, Down, 
Left, or Right) or Tab keys (Tab, Shift+Tab)

To replace all of the text in a cell Select the cell, press the Space Bar, and then enter new contents using the 
keyboard.
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Uploading Assets

Uploading a media file creates an asset in the Streamline Play system with metadata automatically ported from the 
media file. You must have permission to upload media files to the Streamline Play system.

Uploading a Single Asset Through the Upload Panel

You can select a media file from a local file system and upload it to the Streamline Play system.

To upload an asset through the Upload panel

1. In the main toolbar, click the  Assets Upload icon.

The Upload panel opens.

2. Use the Mapping Profile list to select the mapping profile to use to import media file metadata into the 
Streamline Play asset created by uploading a media file:

• Default File Mappings — refer to the section “Default File Mappings” on page A–2 to view mappings.

• Dublin Core — refer to the section “Dublin Core” on page A–3 to view mappings.

Your Streamline Play system may contain additional mapping profiles.

3. Use the File Storage list to select the Default file storage method to ingest media files into your Streamline 
Play system.

The Default file storage method to automatically pushes ingested media files to devices to the video server in 
your Streamline Play system for playout.

4. To select the media file to upload, perform one of the following actions:

• Drag and drop the media file from its location to the Upload panel.

• In the Upload panel toolbar, click the  Add Files icon, navigate to the media file location, and then click 
Open.

To edit the text in a cell Select the cell, press the Insert key, press the Left and Right Arrow keys 
to position the cursor, and then insert new content using the keyboard. 
Press the Delete key to delete individual characters.

To change the status of a check 
box in the selected cell

Select the cell, and then press the Space Bar to reverse the cell status.

To scroll horizontally Click and drag the horizontal scroll bar at the bottom of the panel.

To scroll vertically Roll the mouse wheel, or click and drag the vertical scroll bar on the right 
side of the panel.

To move a column Click and drag the column header to a new location in the panel.

Table 2.3  Column-based Panel Navigation

Desired Effect Action to Perform
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The Upload panel displays the selected media file.

5. In the Upload panel, click Upload to the right of the media file to upload to the Streamline Play system.

Streamline Play creates an asset for the uploaded media file and displays the asset in the Assets panel.

Uploading Multiple Assets Through the Upload Panel

When using the Google® Chrome® or the Mozilla Firefox® browser, a folder can also be selected from a local file 
system and all files contained in that folder will be uploaded to the Streamline Play system. Each media file in the 
folder will have an entry in the Upload panel, and will create an asset in the Streamline Play system once uploaded.

To upload multiple assets through the Upload panel

1. In the main toolbar, click the  Assets Upload icon.

The Upload panel opens.

2. Use the Mapping Profile list to select the mapping profile to use to import media file metadata into the 
Streamline Play asset created by uploading a media file:

• Default File Mappings — refer to the section “Default File Mappings” on page A–2 to view mappings.

• Dublin Core — refer to the section “Dublin Core” on page A–3 to view mappings.

Your Streamline Play system may contain additional mapping profiles.

3. Use the File Storage list to select the Default file storage method to ingest media files into your Streamline 
Play system.

The Default file storage method to automatically pushes ingested media files to devices to the video server in 
your Streamline Play system for playout.

4. Drag and drop the asset folder from its location to the Upload panel.

The Upload panel updates to display an entry for each media file in the folder.

5. To upload all the of the files listed in the Upload panel to the Streamline Play system, click the  Upload All 
icon in the panel toolbar.

Streamline Play creates an asset for each uploaded media file and displays the assets in the Assets panel.

6. To upload a specific media file, click Upload to the right of the media file to upload to the Streamline Play 
system.

Streamline Play creates an asset for the uploaded media file and displays the asset in the Assets panel.
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Removing Files from the Upload Panel

You can choose to remove a media file from the Upload panel to avoid uploading it to the Streamline Play system. 
This is useful when you have selected the contents of an entire folder for upload but realize that some files are not 
required, or noticing that you have selected the wrong media file for upload.

To remove one or all files from the Upload panel

1. To remove a single media file, click Remove to the right of the media file to remove the media file from the 
upload list.

Streamline Play removes the selected media file from the Upload panel.

2. To remove all listed media files from the Upload panel, click the  Remove All icon in the panel toolbar.

Streamline Play removes all media files from the Upload panel.

3. To upload the remaining media files listed in the Upload panel to your Streamline Plays system, complete one 
of the following steps:

• Single media file — step 5 the procedure “To upload an asset through the Upload panel” on page 2–7.

• Multiple media files — step 5 the procedure “To upload multiple assets through the Upload panel” on 
page 2–8.

Approving Assets in the Upload Panel

You can approve a collection of assets before they are uploaded to the Streamline Play system. You must have 
permission to approve assets. To approve a single asset, you must first upload it to the Streamline Play system and 
then use the procedure “To approve an asset through the Asset Editor panel” on page 2–11 to approve it.

To approve multiple assets through the Upload panel

1. In the Upload panel, click the  Approve All icon in the main toolbar of the Upload panel.

2. Click the  Upload All icon in the main toolbar of the Upload panel.

Streamline Play creates an asset for each uploaded media file and displays the assets in the Assets panel.

Requesting Approval for an Asset

When an asset is uploaded to the Streamline Play system, and you do not have approval permissions, it is 
automatically labeled as Unapproved. When you request approval for a new asset, users with approval permissions 
receive an entry in their Asset Approvals panels, noting that an asset is pending their approval.

To request approval for an asset

1. In the main toolbar, click the  Assets Upload icon.

The Upload panel opens.

2. Use the Mapping Profile list to select the mapping profile to use to import media file metadata into the 
Streamline asset created by uploading a media file:

• Default File Mappings — refer to the section “Default File Mappings” on page A–2 to view mappings.

• Dublin Core — refer to the section “Dublin Core” on page A–3 to view mappings.

Your Streamline system may contain additional mapping profiles.

3. Use the File Storage list to select the Default file storage method to ingest media files into your Streamline 
Play system.

The Default file storage method to automatically pushes ingested media files to devices to the video server in 
your Streamline Play system for playout.
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4. To select the media file to upload, perform one of the following actions:

• Drag and drop the media file from its location to the Upload panel.

• In the Upload panel toolbar, click the  Add Files icon, navigate to the media file location, and then click 
Open.

The Upload panel displays the selected media files.

5. In the Upload panel, click Upload to the right of the media file to upload to the Streamline Play system.

Streamline Play creates an asset for the uploaded media file and displays the asset in the Assets panel.

6. In the main toolbar, click the  Assets Browser icon.

The Assets panel opens.

7. In the Assets panel, double-click the asset to submit for approval.

The selected asset opens in Asset Editor panel.

8. In the Asset Editor panel, click the  Request Approval icon in the bottom toolbar.

The Asset Editor panel displays the message “Pending Approval” in the bottom toolbar. The Asset panel 
displays a check mark in the Submitted column of the selected asset.

Previewing a Media File

You can preview the media files attached to an asset. This enables you to verify the file contents, and ensure the file 
matches the asset description or the work order criteria.

To preview a the media file of an asset

1. In the main toolbar, click the  Assets Browser icon.

The Assets panel opens.

2. In the Assets panel, double-click the asset to preview.

The selected asset opens in Asset Editor panel.

3. In the Asset Editor panel, click the thumbnail of the asset.

• Image assets — a new tab opens in your browser to display the asset image.

• Audio or Video — depending on your web browser settings, a copy of the media file automatically 
downloaded or you are prompted to open or save the file to your computer.

Approving and Rejecting an Asset

There are two methods for approving/rejecting an asset: the Asset Editor panel for the specific asset, or the Asset 
Approvals panel which lists all the assets pending your approval. Both methods are outlined in this section.
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Using the Asset Editor Panel

When an asset is uploaded, users with the Approve Assets permission can approve or reject the asset directly from 
its Asset Editor panel. The status of the asset is reported in the bottom toolbar of the Asset Editor panel and in the 
Approval column of the Assets panel.

To approve an asset through the Asset Editor panel

1. In the main toolbar, click the  Assets Browser icon.

The Assets panel opens.

2. In the Assets panel, double-click the asset to preview.

The selected asset opens in Asset Editor panel.

3. In the Asset Editor panel, click the  Approve icon in the bottom toolbar.

The Asset Editor panel displays the message “Approved” in the bottom toolbar. The Asset panel displays a 
check mark in the Approved column of the selected asset.

To reject an asset through the Asset Editor panel

1. In the main toolbar, click the  Assets Browser icon.

The Assets panel opens.

2. In the Assets panel, double-click the asset to preview.

The selected asset opens in Asset Editor panel.

3. In the Asset Editor panel, click the  Unapprove icon in the bottom toolbar.

The Asset Editor panel displays the message “Not Approved” in the bottom toolbar. The Asset panel clears the 
Approved column of the selected asset.

Using the Asset Approvals Panel

When at least one asset is pending your approval, the main toolbar in the Streamline Play displays the Assets 
Pending Approval icon. Clicking this icon opens the Asset Approvals panel which lists all the assets pending your 
approval. From this panel you can approve/reject more than one asset at a time.

To approve assets through the Asset Approvals panel

1. In the main toolbar, click the  Assets Pending Approval icon.

The Asset Approvals panel opens.

2. In the Asset table, select the assets to approve. 
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3. Click the  Approve icon in the toolbar.

The Asset Approvals panel no longer displays the approved assets, and their Streamline Play system status 
changes to “Approved”.

To reject assets using the Asset Approvals panel

1. In the main toolbar, click the  Assets Pending Approval icon.

The Asset Approvals panel opens.

2. In the Asset table, select the assets to reject. 

3. Click the  Reject icon in the toolbar. 

The Asset Approvals panel no longer displays the rejected assets, and their Streamline Play system status 
changes to “Not Approved”.
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Add Assets to NRCS Stories
After uploading all of your assets to Streamline Play, you can add assets to NRCS stories as MOS objects. When 
you open an NRCS running order in Streamline Play, all of the asset MOS objects are automatically loaded into a 
rundown. The RundownControl component of Streamline Play enables you to playout and control the assets in the 
generate rundown.

This chapter discusses the following topics:

• Add Assets to NRCS Stories as MOS Objects

• Add MOS Object Placeholders to Stories
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Add Assets to NRCS Stories as MOS Objects

Journalists can use the Streamline Play plugin to add assets into their NRCS stories as MOS objects. The Streamline 
Play plugin is a web plugin that does not require installation on your authoring computer.

To use the Streamline Play plugin to add assets to an NRCS story

1. In your NRCS, edit a story to which to add assets from Streamline Play.

2. Open the Streamline Play plugin in your NRCS.

The Streamline Play plugin opens in a window.

3. Use your Streamline Play user account credentials to log in to Streamline Play.

4. In the main toolbar of the Streamline Play plugin, click the  Browse icon.

The Assets panel opens listing the available assets.

5. From the Assets panel, click and drag the thumbnail of the asset to add to your NRCS story into your story.

6. Release the asset to place it in your NRCS story.

Your NRCS story editor displays the asset as a MOS object.

Add MOS Object Placeholders to Stories

When the video clip you want to add to an NRCS story does not exist in Streamline Play, you can add a MOS object 
placeholder to the story for the media. The added MOS object placeholder sends a request to Streamline Play to 
create an asset for the MOS object placeholder in the NRCS story. After a Streamline Play operator creates the 
requested asset, your NRCS exchanges the MOS object placeholder with the new MOS object that contains the 
requested asset.
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To add MOS object placeholder to an NRCS story

1. In your NRCS, edit a story to which to add assets from Streamline Play.

2. Add a MOS placeholder for a Streamline Play asset to your NRCS story.

3. Save your NRCS story.

Streamline Play automatically creates an asset for the MOS placeholder. After the Streamline Play operator 
adds a media file the requested asset, your NRCS exchanges the MOS object placeholder with the new MOS 
object that contains the requested asset.

Create an Asset for a MOS Object Placeholder

To complete a MOS placeholder, you must use Streamline to add a media file the asset created by the MOS 
placeholder.

1. Use a supported web browser to open the Streamline Play web page provided by your Streamline Play 
administrator.

2. Use your Streamline Play user account credentials to log in to Streamline Play.

3. In the main toolbar of the Streamline Play plugin, click the  Browse icon.

The Assets panel opens listing the available assets.

4. In the Assets panel, use MOS placeholder slug name to locate the asset created for the MOS placeholder.

5. Double-click the asset.

The selected asset opens in an Asset Editor panel.

6. Add the required information, marked by an asterisk (*), to the asset.

1. In the toolbar, click the  Update File icon.

The Upload panel opens.

2. Use the Mapping Profile list to select the mapping profile to use to import media file metadata into the 
Streamline Play asset created by uploading a media file:

• Default File Mappings — refer to the section “Default File Mappings” on page A–2 to view mappings.

• Dublin Core — refer to the section “Dublin Core” on page A–3 to view mappings.

Your Streamline Play system may contain additional mapping profiles.
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3. To select the media file to upload, perform one of the following actions:

• Drag and drop the media file from its location to the Upload panel.

• In the Upload panel, click the Choose File, navigate to the media file location, and then click Open.

The Upload panel displays the selected media file.

4. In the Upload panel, click Upload to the right of the media file to upload to the Streamline Play system.

Streamline Play updates the asset with the uploaded media file.

5. Use the  Send To list to select the target video server to which to send the finished asset.

Streamline Play sends the asset to the selected target video server. The status of the MOS object that contains 
the asset changes to “Ready”.
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Rundown Playout
RundownControl™ enables you to playout the MOS video server and MOS CG shots contained in an NRCS 
rundown. You can customize the layout of the RundownControl windows to fit your workflow.

The following topics are discussed in this chapter:

• Start RundownControl

• Open a Rundown

• Rundown Playout

• Custom Controls View

• Timer View
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Start RundownControl

RundownControl enables you to open and work with rundowns created with a NRCS.

 Only one instance of RundownControl can be running at any time on a client computer. If an attempt is made to 
start a second RundownControl, an error dialog box opens to inform that RundownControl is currently open.

To start RundownControl

1. On the desktop, double-click the Rundown Control icon.

When RundownControl contains user profiles in addition to the overdrive (Default User) user profile, the 
Select User dialog box opens. For RundownControl systems that only contain the overdrive (Default User) 
user profile, skip to the results of step 3.

To work without a user profile during a RundownControl session, do the following:

a. Click the Select User dialog box Windows Close button.

b. Skip to the results of step 3.

2. From the User list, select the user profile to work with for the RundownControl session.

The selected user profile defines the following preferences for the RundownControl session:

• Custom perspective layout

• Hot key assignments

• Timer settings

• Custom Control button assignments

• Rundown table column layout

• Setting on the Rundown Settings, GPI, and NRCS Settings tabs in RundownControl Options dialog box.

Any preference changes made during an RundownControl session are saved with the selected user profile.

3. Click Select User.

For users that have a password, the Enter Password dialog box opens.

To enter a user password, follow these additional steps:

a. In the Enter Password box, enter the password for the selected user profile.

b. Click OK.
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RundownControl opens using the user preferences from the selected user profile, displayed in the 
RundownControl title bar.

The RundownControl license state is checked each time RundownControl is started. The License Error 
dialog box displays for any of the following states:

• No Licenses Installed — a license is not installed on the Streamline Play Server.

• License Invalid — the installed license is not valid for the switcher in the RundownControl system.

• License Expiring Soon — the installed license is valid, but will soon expire.

• Maximum Connections Exceeded — there are no available licensed client connections to the Streamline 
Play Server are currently in use.

For each of the about states, resolve the license error and restart RundownControl.

4. Use the Help menu to select Contents to open the RundownControl Online Help system.

5. Use the Help menu to select About to view copyright information and the current RundownControl version 
number in the About RundownControl dialog box.

Switch User Profiles

While working in RundownControl, you can switch user profiles to change your workspace settings. This feature is 
very useful when you select the incorrect user for a RundownControl session.

To switch user profiles during a RundownControl session:

1. In RundownControl, use the File menu to select Switch User.

The Confirm Application Restart dialog box opens.

2. Click Yes.

An Alert opens.
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3. Click Yes.

RundownControl closes and the Select User dialog box opens.

4. From the User list, select the new user profile to work with during the RundownControl session.

5. Click Select.

For users that have a password, follow these additional steps:

a. In the Enter Password box, enter the password for the selected user profile.

b. Click OK.

RundownControl opens using the user preferences from the selected user profile.

Open a Rundown

RundownControl opens rundowns created in an NRCS to play out the MOS video server and MOS CG shots 
contained the rundown stories. 

 NRCS rundowns must be published and exported to the Streamline Play MOS Gateway before they can be 
opened by RundownControl.

To open an NRCS rundown:

1. In RundownControl, select File > Open Rundown.

The Open Rundown dialog box opens.

2. Click the NRCS Rundown tab.

The NRCS Rundown tab opens.

3. To update the list of available rundowns, click Refresh List.

4. Select the rundown to open.

5. Click Open to open the selected rundown.

The Open Rundown dialog box closes and the Rundown table displays the shots contained in the selected 
rundown.
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Rundown Table

The Rundown table is the main window in RundownControl. You can tailor the windows in the RundownControl 
GUI to suit your unique operational and production requirements. When you open an NRCS rundown in 
RundownControl, the Rundown table displays the video clips and CGs contained in the rundown as shots. The title 
bar at the top of the Rundown table window displays the name of the currently open rundown.

Figure 4.1  The Rundown Table

When all of the information about a shot cannot be viewed in the Rundown table, hover over the truncated 
information to view a ToolTip. The ToolTip displays a summary of all the shot information. To view shot 
information in the Shot Details dialog box, right-click a shot and select View Shot Details from the shortcut menu.

Select Rundown Table Columns

The following Rundown table columns available to display information for each shot in a rundown:

• Audio — audio defined for the shot.

• Auto Advance — automatic advance setting.

• Conflicts — a conflict that could prevent the shot from being taken to air. For example, no free device outputs.

• Exceptions (!) — an icon that identifies a conflict.

• Index — shot sequence index number.

• On-Air Status — current status of a shot: On Air, Prepared, Shot Cued, or Incomplete.

• Shot Icon — an icon that identifies the shot.

• Shot Information — a description of the shot.

• Template — master template, devices, and clips used in the shot.

• Thumbnail — video clip thumbnail.

• Timing — timing information from NRCS timers.

You can display, hide, or move each column in the Rundown table.



4–6 • Rundown Playout Streamline Play User Guide (v23.5)

 To select Rundown table columns

1. In RundownControl, use the Window menu to select Edit Columns.

The Edit Columns dialog box opens.

The tree view on left displays the Available Rundown table columns, while the right tree view displays the 
Current columns displayed in the Rundown table.

2. To add a column to the Rundown table:

a. In the Available columns tree view on the left, select the column or columns to add to the Rundown table.

Select a heading node to select all of the columns contained by the node.

b. Click Add Columns.

RundownControl adds the selected column or columns to the Current columns tree view on the right.

3. To remove a column from the Rundown table:

a. In the Current columns tree view on the right, select the column or columns to remove from the Rundown 
table.

Select a heading node to select all of the columns contained by the node.

b. Click Remove Columns.

The selected column or columns move to the Available columns tree view on the left.

4. To display the default columns in the Rundown table:

a. Click Load Defaults.

The Reload Defaults? alert opens.

b. Click Yes.

The Reload Defaults? alert closes, and the Available and default Current column tree views display the 
default column settings.

5. After selecting the columns for the Rundown table, click Save.

The Edit Rundown Columns dialog box closes, and the Rundown table displays the selected columns.



Streamline Play User Guide (v23.5) Rundown Playout • 4–7

Move Rundown Table Columns

You can move Rundown table columns by clicking and dragging them to a new location in the table.

To Move Rundown table Columns

1. In the Rundown table, place the mouse pointer over the heading of the column to move.

2. Click and drag the column left or right to a new location in the Rundown table.

3. Release the mouse button the place the selected column at the new location in the Rundown table.

 Rundown Status

The following background colors are used in the Rundown table to report the status of shots in the rundown:

• Normal — the shot is valid, ready to be prepared.

• Prepared — the shot is prepared to go on air.

• Reprepare — the shot must be reprepared before it can transition on air.

• On Air — the shot is on air.

• Unpreparable — the shot failed to prepare.

• Fixed-MLE Template — the shot uses a Fixed-MLE Template.

• MOS Character Generator — the shot uses a MOS CG device.

• MOS Video Server — the shot uses a MOS video server.

• Cued or Cuing — the clip in this shot is cued in advance.

• Auto Advance — the shot automatically advances to the next shot at a set time.

• Break — the shot is a break story from the NRCS.

The following icons are used in the Rundown table to report the status of shots in the rundown:

• Warning — the shot is valid but one or more clips or presets associated with a device in the shot are 
missing.

• Error — the shot cannot be prepared.
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Rundown Playout

After opening a rundown you can use RundownControl to playout the shots contained rundown.

 Only one RundownControl client at a time can play a rundown.

To play a rundown

1. With a rundown open, use one of the following methods to start playing a rundown:

• In the toolbar, click Play Rundown .

• Use the Playout menu to select Play Rundown.

Starting rundown playout automatically prepares the first shot in the rundown. When there are no preparable 
shots in a rundown, RundownControl enters Playout mode and waits for input.

2. Press the Space Bar to take the prepared shot on air and automatically prepare the next shot in the rundown.

3. To select the next shot to prepare, use one of the following commands from the Playout menu or toolbar:

• Prepare Previous — while in Playout mode, prepare the shot preceding the currently prepared shot in 
the Rundown table.

› When no shot is on air, and no shot is prepared, prepare the first preparable shot.

› When a shot is on air, but no shot is prepared, prepare the preparable shot before the on air shot.

› When a shot is already prepared, prepare the previous shot.

• Prepare Next — while in Playout mode, prepare the next preparable shot in the rundown.

› When no shot is on air, and no shot is prepared, prepare the first preparable shot.

› When a shot is on air, but no shot is prepared, prepare the first preparable shot after the on air shot.

› When a shot is already prepared, prepare the next shot.

4. Use one of the following methods to stop rundown playout and return to Edit mode:

• In the toolbar, click Stop Rundown .

• Use the Playout menu to select Stop Rundown.

Jump to a Shot

While the rundown is playing, you can select any shot in the rundown to prepare as the next shot to take to air.

To jump to a shot in the rundown and prepare it as the next shot to take to air:

1. In the Rundown table, select the next shot to take to air.

Rundown control highlights the selected shot with yellow borders displayed along the top and bottom edges of 
the shot row in the Rundown table.

2. Double-click the selected shot.

RundownControl prepares the selected shot as the next shot to take to air.
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Custom Controls View

The buttons in the Custom Controls view can be assigned to specific switcher custom controls. Clicking a Custom 
Control button runs the associated switcher custom control. The Custom Controls view contains six tabs for 
organizing assigned Custom Control buttons. For example, all of the switcher custom controls used in the news 
show could be placed together on the “News” tab. When more Custom Control buttons are required on a tab, the 
Custom Controls view can be enlarged to add buttons to the tab.

Figure 4.2  Custom Controls View

Transport Controls

Custom Controls view contains transport controls for each channel of the MOS video server connected to the 
Streamline Play system. The trans port controls enable you to control the playout of a video clip on a channel. The 
transport controls for each channel are as follows:

Rwd — rewind to the start of the video clip on a channel.

Stop — stop playing the video clip on a channel.

Play — start playing the video clip on a channel.

FFwd — fast forward to the end of the video clip on a channel.

Pause — pause the playing video clip on a channel. Click the Play to resume playing the video clip.

FAdv — move one frame forward in the video clip on a channel.

FRev — move one frame backward in the video clip on a channel.

Loop On — turn loop mode on for a channel. A playing video continues playout until the play head reaches the end 
of the video clip where it loops back to the start of the video clip and restarts playout of the video clip. Looping 
playout continues until you click Loop Off.

Loop Off — turn loop mode off for a channel. A playing video clip continues playout until the play head reaches 
the Out Point and stops the playout.

Assigning a Custom Control to a Button

Buttons in the Custom Controls view that are assigned to a switcher custom control are labeled with the name of the 
custom control. Buttons not assigned a switcher custom control are labeled Not Defined. When an invalid switcher 
custom control is assigned to a button, the button is disabled and grayed out.

 Custom controls must be created on the switcher, as detailed in the switcher Operator’s Manual, before they can 
be accessed from within RundownControl.
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To assign a switcher custom control to a RundownControl Custom Control button:

1. Start RundownControl.

2. In the Custom Controls view, click the tab that contains the Custom Control button to assign a switcher 
custom control.

3. Right-click the Custom Control button to assign a switcher custom control.

The Configure Custom Control dialog box opens.

The Configure Custom Control dialog box only lists the custom controls that are stored on the switcher. 
Invalid switcher custom controls in the list are displayed in Dark Red. To sort the custom controls list, click 
the Bank/Button or Name column heading to sort the list by the selected column. Click the selected column 
heading once again to reverse the sort order of the column.

 RundownControl is only able to access custom controls stored in the first 12 custom control banks on a switcher.

4. Use the Button/Bank column to select the switcher custom control to assign to the selected Custom Control 
button.

5. Click OK.

The Configure Custom Control dialog box closes and the selected Custom Control button is labeled with the 
name of the selected switcher custom control.

Master templates are able to assign custom controls to the buttons in the Prepared Customs and On-Air Customs 
views in RundownControl.

To clear the assigned switcher custom control from a RundownControl Custom Control button:

1. In the Custom Controls view of RundownControl, click the tab that contains the Custom Control button to 
clear.

2. Right-click the Custom Control button to clear.

The Select Custom Control dialog box opens.

3. Use the Button/Bank column to select None.

4. Click OK.

The Select Custom Control dialog box closes and the switcher custom control is removed from the selected 
Custom Control button. The button is relabelled Not Defined.
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To clear all Custom Control buttons in a tab:

1. In the Custom Controls view of RundownControl, right-click the Custom Controls tab from which to clear 
all Custom Control buttons.

The Shortcut menu opens.

2. Use the Shortcut menu to select Clear Custom Control Tab.

The Remove Custom Controls dialog box opens.

3. Click Yes.

Switcher custom controls are removed from all Custom Control buttons in the selected tab, and the buttons are 
relabeled Not Defined.

Reloading Custom Controls

When changes are made to custom controls on the switcher, the custom controls list in RundownControl is not 
automatically updated. A manual reload of the switcher custom controls is required to update the custom control list 
in RundownControl.

To reload custom controls into RundownControl:

• In RundownControl or TemplateEditor, select Tools > Reload Custom Controls.

Custom Controls Tab Names

The name of each of the six tabs in the Custom Controls view can be change to describe the Custom Control buttons 
contained in the tab.

To rename a Custom Controls tab:

1. In the Custom Controls view of RundownControl, right-click the Custom Controls tab to rename.

The Shortcut menu opens.

2. Use the Shortcut menu to select Rename Tab.

The Rename Tab dialog box opens.

3. In the Name box, enter a new name for the selected tab.

The length of the tab name is automatically limited by the Name box. To reset the tab name to the default 
name, clear the Name box.

4. Click OK to rename the selected tab and close the Rename Tab dialog box.
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Timer View

The Timer view in RundownControl contains six groups which each contain six configurable timers that you can 
use to keep track of clip time, shot time, program time, the time of day, and NRCS timing. You can also use a timer 
as a manually controlled stopwatch.

Figure 4.3  Timers View

You can configure any timer in a group to display one of the following times:

• Manual — A count up or down timer that is manually started and stopped. This type of timer displays the time 
passed (count up) or remaining (count down) since the timer was started. This is the default configuration of 
timers two to six.

• Program Time Elapsed — a timer that automatically starts when the first shot in a rundown transitions on air 
and stops when the rundown ends. This type of timer displays the time passed since the program went on air. 
This is the default configuration for timer one.

• Shot Time Elapsed — a timer that automatically starts when a shot transitions on air and resets when the 
transition between shots ends. This type of timer displays the time passed since the shot went on air. This is the 
default configuration for timer two.

• Story Time Elapsed — a timer that automatically starts when a story from an NRCS within a shot goes on air 
and resets when the story index changes. This type of timer displays the time passed since the story went on air.

• Clip Time Elapsed — a timer that automatically starts when a clip within a shot goes on air and stops when the 
clip ends. This type of timer displays the time passed since the clip went on air.

• Clip Time Remaining — a timer that automatically starts when a clip within a shot goes on air and stops when 
the clip ends. This type of timer displays the time remaining in the clip.

• Clock (12 Hour) — the time of day displayed in 12 hour format.

• Clock (24 Hour) — the time of day displayed in 24 hour format.

• NRCS Estimated Duration Remaining — a story timer based on the story duration calculated by the NRCS 
using the story word count, anchor read rate, and media time. This timer starts when the story index number 
changes.

• NRCS Target Time Remaining — a story timer based on the story target time manually entered in the NRCS. 
This timer starts when the story index number changes.

• NRCS Media Time Remaining — a shot timer based on media duration. In the NRCS, media duration can be 
manually entered or automatically calculated.

› When a story contains multiple shots (CAM1, VO) the timer starts when RundownControl takes the shot 
containing the video server.

› When there are multiple video server shots in a story, the first video server shot triggers the countdown and 
RundownControl ignores the remaining video server shots.

• NRCS Rundown Start Time Remaining — a timer that uses the rundown start date and time to countdown 
00:00:00, when the show should start.

• NRCS Rundown Duration Remaining — a timer that counts down from “Black to Black” or the start of the 
show to the end of the show.

• NRCS Custom Time — use a custom NRCS timing source.
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Timer Group Names

Each tab in the Timers view contains a timer group of six timers. You can change the name of each group tab to 
describe the timers contained in the group.

To rename a timer group tab:

1. In the Timers view of RundownControl, right-click the Group tab to rename.

The Rename Timer Group dialog box opens.

2. In the Rename the timer group box, enter a new name for the selected group.

The Rename Timer Group dialog box warns you when the entered group name is too long for the tab of the 
selected group. To reset the group name to the default name, clear the Rename the timer group box.

3. Click OK to rename the selected tab and close the Rename Tab dialog box.

Timers in a Group

For each timer in a group, you can configure the timing source to display in the timer.

To configure a timer in the Timers view:

1. In the Timers view of RundownControl, click the Group tab to that contains the timer to configure.

2. Right-click the timer to configure.

The Configure Timers dialog box opens for the selected timer.

To quickly open the Configure Timers dialog box and select the configuration tab for a timer, right-click the 
timer to configure.

3. In the Configure Timers dialog box, click the tab associated with the timer to configure.

The Configuration tab for the selected timer opens.
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4. Use the list in the Source section to select the source timed by the timer. The available sources are as follows:

• Disabled — deactivate the timer.

• Manual 

› To set the timer direction, go to step 5.

› To set the timer duration, go to step 6.

› To customize timer behavior, go to step 7.

› Go to step 10 to save the timer configuration.

• Program Time Elapsed 

› Go to step 10 save the timer configuration.

• Shot Time Elapsed 

› Go to step 10 to save the timer configuration.

• Story Time Elapsed 

› Go to step 10 to save the timer configuration.

• Clip Time Elapsed 

› To customize timer behavior, go to step 7.

› To set the timer duration, go to step 8.

› Go to step 10 to save the timer configuration.

• Clip Time Remaining 

› To customize timer behavior, go to step 7.

› To set the timer duration, go to step 8.

› Go to step 10 to save the timer configuration.

• Clock (12 Hour) 

› Go to step 10 to save the timer configuration.

• Clock (24 Hour) 

› Go to step 10 to save the timer configuration.

• NRCS Estimated Duration Remaining 

› To customize timer behavior, go to step 7.

• NRCS Target Time Remaining 

› To customize timer behavior, go to step 7.

• NRCS Media Time Remaining 

› To customize timer behavior, go to step 7.

• NRCS Rundown Start Time Remaining 

› To customize timer behavior, go to step 7.

• NRCS Rundown Duration Remaining 

› To customize timer behavior, go to step 7.

• NRCS Custom Time 

› To set the timer direction, go to step 5.

› To customize timer behavior, go to step 7.

› To select the custom NRCS timing source timed by the timer, go to step 9.
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5. When Manual or NRCS Custom Time is selected as the timer Source, select one of the following options in 
the Direction section to set direction in which a timer measures time:

• Count Up — measure the time passed since the timer was started. The starting time is set in the Initial 
Value section.

• Count Down — Click this option to measure the time remaining in a pre-set time period. The length of the 
time period is set in the Initial Value section.

6. When Manual is selected as the timer Source, use the following boxes in the Duration section to set the time 
duration used by a timer:

• HH — Enter in this box the number of hours for the time duration.

• MM — Enter in this box the number of minutes for the time duration.

• SS — Enter in this box the number of seconds for the time duration.

When the Count Down option is selected, this value sets the length of the time duration used by the timer. The 
Enable Count Through Duration option in the Other Options section controls timer behavior when the set 
duration is reached.

When the Count Up option is selected, this value sets the time from which the timer starts timing.

7. When Manual, Clip Time Elapsed, Clip Time Remaining, or an NRCS source is selected as the timer 
Source, use the following options in the Other Options section to customize timer behavior:

• Enable Color Status Indicators — select this check box to automatically color the timer numbers red 

 when the time reaches within 10 seconds of the time set in the Duration section.

• Enable Count Through Duration — select this check box to continue timing after a timer reaches the set 
duration time. The following occurs after the set duration time:

› Count down timers continue counting down in negative time until stopped. A minus sign (-) is added to 
the time.

› Count up timers continue timing past the set duration time.

8. When Clip Time Elapsed or Clip Time Remaining is selected as the timer Source, use the Clip Source menu 
in the Source section to select the clip source to time. This list only contains the clip sources used in a Master 
template.

9. When NRCS Custom Time is selected as the timer Source, use the list in the Custom NRCS Timing Source 
section to select the custom NRCS timing source timed by the timer. This list only contains the NRCS timing 
sources defined in the Streamline Play Server NRCS Timing Configuration web page of the Streamline Play 
Server.

10. Click OK to save changes and close the Configure Timers dialog box.

Controlling Manual Timers

Manual timers are the only type of timers that require you to control starting, stopping, and resetting. All other types 
of timers are controlled automatically by RundownControl.

To control a Manual timer:

1. To start a timer, click the timer title or time display.

2. To stop a running timer, click the timer title or time display.

3. To reset a timer, double-click the timer title or time display. The results of resetting a timer are as follows:

• Count up timers are reset to zero (0:00).

• Count down timers are reset to the set duration time.

• A running timer resets to the initial timer value, then automatically restarts timing from the initial value.
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Manual Timer Hot Keys

Hot keys can be used to start, stop, and reset Manual timers. By default, hot keys are not assigned to the timers in 
the Timers view. Hot keys can be assigned to all six timers, but only work with the Manual timers currently in use. 
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Appendix A: Mapping Profiles
The sections in this appendix show the mapping of media file metadata properties to Streamline properties for the 
mapping profiles included with a Streamline Server.

This appendix lists the mappings contained in the following mapping profiles:

• Default File Mappings

• Dublin Core
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Default File Mappings

This profile maps standard media file properties to Streamline asset attribute properties.

Table A.1  Mappings Contained in the Default File Mapping Profile

Asset Attribute Media File Property XMP Category

encodedDate Encoded_Date General

format Format General

duration Duration General

overallBitRate OverallBitRate General

fileSize FileSize General

videoStreams_duration Duration Video

videoStreams_bitRate BitRate Video

videoStreams_codec Codec Video

videoStreams_width Width Video

videoStreams_height Height Video

videoStreams_pixelAspectRatio PixelAspectRatio Video

videoStreams_displayAspectRatio DisplayAspectRatio Video

videoStreams_rotation Rotation Video

videoStreams_frameRateMode FrameRate_Mode/String Video

videoStreams_frameRate FrameRate Video

videoStreams_frameCount FrameCount Video

videoStreams_interlacement Interlacement Video

videoStreams_standard Standard Video

videoStreams_colorSpace ColorSpace Video

videoStreams_chromaSubsampling ChromaSubsampling Video

videoStreams_bitDepth BitDepth Video

videoStreams_compressionMode Compression_Mode Video

videoStreams_streamSize StreamSize Video

videoStreams_language Language Video

audioStreams_duration Duration Audio

audioStreams_bitRate BitRate Audio

audioStreams_samplingRate SamplingRate Audio

audioStreams_samplingCount SamplingCount Audio

audioStreams_channels Channels Audio

audioStreams_bitDepth BitDepth Audio

audioStreams_language Language Audio

audioStreams_streamSize StreamSize Audio

audioStreams_codec Codec Audio
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Dublin Core

This profile contains the all of the mappings from the Default mapping profile and adds mappings for the standard 
Dublin Core metadata properties. For more information about Dublin Core metadata properties, refer to the web 
page http://wiki.dublincore.org/index.php/User_Guide.

imageStreams_codec Codec Image

imageStreams_width Width Image

imageStreams_height Height Image

imageStreams_colorSpace ColorSpace Image

imageStreams_chromaSubsampling ChromaSubsampling Image

imageStreams_bitDepth BitDepth Image

imageStreams_compressionMode Compression_Mode Image

imageStreams_streamSize StreamSize Image

Table A.2  Additional Mappings Contained in the Dublin Core Mapping Profile

Asset Attribute Media File Property XMP Category

encodedDate Encoded_Date General

format Format General

description Description XMP

rights Rights XMP

language Language XMP

tags Subject XMP>

contentRegion Coverage XMP

creator Creator XMP

name Title XMP

type Type XMP

Table A.1  Mappings Contained in the Default File Mapping Profile

Asset Attribute Media File Property XMP Category

http://wiki.dublincore.org/index.php/User_Guide
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